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Introduction

The Fury-800 is a software synthesizer plug-in for Microsoft Windows (VST2/VST3)
and Apple macOS (VST2/VST3/AU) simulating the KORG® Poly-800 Polyphonic
Synthesizer from 1983. It is written in native C++ code for high performance and low
CPU consumption. The main features are:

Two band-limited DCOs with individual envelope generators (DEG)
Single (paraphonic) lowpass VCF and Noise

On-board sequencer and Chord Memory

Pseudo-stereo Chorus effect

SysEx (import & export) and tape dump (import only)

Resizable user interface (not “N” version)

Tweaks:

o Up to 64 voices polyphony with Velocity

o "“God Mode” for real polyphony

o Continuous parameter values and direct access

e MTS-ESP (https://oddsound.com/) dynamic micro-tuning support
e All parameters can be controlled by MIDI controllers

e Plug-in supports Windows and macOS (32 bit and 64 bit)

The Fury-800 is based on the new iPlug2 framework maintained by Oli Larkin and
the iPlug2 team. Big thanks, guys!!! Without your work it would not have been
possible to create a resizable Fury-800 user interface.

To resize the plug-in you just grab the yellow triangle at the bottom right of the Fury-
800 window and drag it. You can save the current window size using the menu entry
“Save Window Size” in the Options Menu.

From The Poly-800...

Once upon a time I promised myself not to create a simulation of an existing piece of
hardware that I do not own by myself. Anyway, after receiving so many mails about
“"Why not recreating the Poly-800?" 1 thought "Why not?”. After all, this could have
been the first polyphonic synthesizer I'd ever had bought - if it were not for the
mighty Bit One *cough, cough*...

In the mid 80’s, it was time for weird and futuristic designs. It was also time for
transition (from analog to digital...) and for relentless cost reduction - how else could
one explain the advent of music machines with zillions of parameters but only two
buttons to edit them? The Yamaha DX7 became an icon of its time (plus beyond), and
other manufacturers gave their new machines a similar look: Parameter numbers and
ranges were printed on the face plate, knobs/sliders disappeared, pseudo-technical
diagrams and LED displays were ubiquitous.

Enter, stage right: The KORG Poly-800 from 1983. It had the look! It was polyphonic!
It was programmable! It was cheap (and inexpensive)! It was sexy! Put on a strap
and you could pose like a guitar player! It had only one filter for all voices? Ouch...

But it also had some outstanding features that are worth mentioning: Two DCOs, each
with their own digital ADBSSR envelope generators (DEG) and a funky way of additive
waveform generation, a VCF with its own ADBSSR DEG, a Chord Memory and on-
board sequencer.
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... To The Fury-800
Well, I added some enhancements to my Fury-800 simulation:

The Fury-800 can be 64 voice polyphonic — the Poly-800 only offered 8 voices
(just 4 in DOUBLE mode).

Velocity is — optionally - available.

Due to technical reasons the Poly-800 was paraphonic with respect to the VCF
(the special chip used for the eight DCOs did not output the individual DCO
signals but a mixture of their octave signals; thus the signal of the DCOs could
only be filtered in their sum). But the God Mode will turn the Fury-800 into a
“true” polyphonic synthesizer.

Where ever useful I turned step-like parameters into their continuous
equivalents. For example you can adjust the /evel of the 8 DCO wave instead of
just turning it on or off.

The sequencer in the Poly-800 offered 256 “steps” - but the correct description
would have been that it offered 256 events (for example a chord of three notes
eats three “steps” and not just one). The sequencer of the Fury-800 is different
and features 1000 “real” steps. In theory you can have sequences of 1000
steps where each step stores a chord of 64 notes. ©

Editing the Poly-800 is no fun because you have to dial each parameter using
the numeric keyboard, and there is no slider to change the parameter’s value
(just two buttons). The Fury-800 has the option to show and edit all parameters
at the same time.

The Chorus effect of the Poly-800 was said to be a stereo chorus. Well, I don’t
want to split hairs here, but in fact it was a mono chorus where the inverted
signal was mixed to the right channel of the Poly-800’s output (quite a common
pattern in these days). The chorus in the Fury-800 also is a mono effect, but
here you can select if the chorus signal shall be inverted when mixed to the
right channel or not.

What's New With Version 2?

After the release of version 1.0, I received lots of mails with appraisals, critics and
suggestions. Two were of utter significance: The mails from Steve Henshaw and
Felix Homann who sent me samples of their original Poly-800 machines. During the
development of the Fury-800 v2.0, Steve even became my all-day sparring partner
and compared v2 against the real thing! Needless to say that meanwhile kraftraum
also Beta-tested the plug-in. All in all this was a labor-intensive but also very amazing
experience!

To tell you the truth, the Fury-800 v1.0 does differ from the original Poly-800 - not so
much sound-wise but parameter-wise. A Fury-800 v1.0 program may sound totally
different than a program with the same parameter settings on a Poly-800, but this is
mainly due to the different parameter ranges on both machines! Furthermore, the
shapes of the envelopes (DEG) are different: While the Fury-800 v1.0 uses
exponentially shaped contours, the Poly-800 envelopes are parabolic and linear.
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Two Modes, Two Worlds

Now changing parameter ranges or other crucial features like envelope shapes etc. on
an existing plug-in is something of a no-go. If such a plug-in is already used in a
project and gets upgraded to a new version, it will obviously sound different than
before — backwards compatibility is needed! Thus I decided to provide two modes of
operation with the Fury-800 v2.0:

e BUCKET MODE
In this mode the Fury-800 v2.0 will sound like the original v1.0. Furthermore, if
you load a program saved with v1.0 it will automatically set the BUCKET MODE.
This is the backwards compatible mode.
Note that in BUCKET MODE the LED display will glow in a rather unfamiliar
green.

e POLY-800 MODE
In this mode the Fury-800 v2.0 will sound like the Poly-800: Parameter ranges
and envelopes are adjusted to those of the original. If you import a program
bank via SysEx, those programs will automatically be set to POLY-800 MODE;
it's the new legacy mode. ©
Note that in POLY-800 MODE the LED display will glow in the familiar red.

You can flip between both modes by pressing the Mode button on the top right of the
Fury-800. It is impressing to hear the differences.

Envelopes...

As stated above, the envelope shapes, timings and parameter ranges in POLY-800
MODE are analyzed from the samples that I received from Felix and Steve. This was
some tough work. I also found that the DEGs of the Poly-800 at very low parameter
values (0 to 2) are very “sloppy” and thus decided to extrapolate them to some more
neat behavior... please forgive my ignorance!

Attack Decay Slope Sustain ReIease§
1 ~ phase ;

BUCKET MODE

R St
v

key pres?sed

Poly-800 MODE

Envelope shapes in BUCKET MODE and Poly-800 MODE
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More Adjustments

In POLY-800 MODE, the VCF parameter ranges are adapted to the those of the
original machine; the same is true for the Chorus and the MG. Note that the
maximum VCF Resonance level is a bit higher than in BUCKET MODE.

Another “feature” of the Poly-800 is that its sound is a bit “thinner” than the original
Fury-800. This is because the Poly-800's internal circuitry shapes the sound by many
components that act like high-pass filter elements. The Fury-800 simulates this effect
using a BRIGHT function that can optionally be switched on or off. At the same time I
also added a +6dB switch.

SysEx And Tape Dump Import

This was a major request by many Poly-800 and EX-800 owners. It would have made
no sense to do an import of the sound data if the Fury-800 parameters were not
adjusted to those of the Poly-800 but now they are.

Note that the Poly-800 Mark I does not support MIDI System Exclusive export.
However, the rack expander EX-800 as well as the Poly-800 Mark II do, and there are
many SysEx sources on the Internet, too.

All the hardware 800's feature the tape dump option i.e. to write their sound &
sequence data to an audio stream which can be recorded (not necessarily only) by a
tape recorder. Since version 2.1 of the Fury-800 it is now possible to import this data
(provided it is stored as a WAV file). However, the success of this operation heavily
relies on the quality of the dump - if you try to import a dump recorded long time ago
on cassette etc. the import may fail.

SysEx Export And MTS-ESP Micro Tuning Support

Fury-800 now features the export of MIDI System Exclusive data for EX-800, Poly-800
Mark II and the MIDI Dump Kit (MDK) extension.

Furthermore the Fury-800 now supports dynamic Priterinnnnns®

micro tuning provided by ODDSounds’s MTS-ESP Ll

(https://oddsound.com/). A tool tip of the TUNE AR RE ,.,rirTuning. Werckmeister 3
Tl et b i

will show the name of the current scale if MTS-
ESP micro tuning is active.

The Fury-800 “"N” Version

Many users with older operating systems (Windows 7, macQOS
10.10 or below) and/or incompatible graphic cards/drivers had

problems with the resizable user interface of version 1.0. Thus, I

decided to provide a non-resizable version of the Fury-800 based on the old iPlug

framework - this is called the "N” version. It should work on almost all machines
(even on 32 bit Macs).


https://oddsound.com/
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General Operation

POLY-800 MODE vs. BUCKET MODE
Version 2.0 of the Fury-800 introduces a new selector for the mode
of operation (see section Two Modes, Two Worlds above):
In POLY-800 MODE all parameter ranges, envelopes etc. are
set to match the original Poly-800. This is important if you

want to recreate classic patches or read SysEx data of the EX-
800 or the Poly-800 Mark II.

In BUCKET MODE the Fury-800 behaves just the same as in version 1.0 - it is
the backwards compatible mode. Personally, I still prefer it over the POLY-800
MODE - somehow natural because I designed it in the first place! Anyway, it is
a matter of taste.

Note that in BUCKET MODE the LED display will glow green while in Poly-800 MODE it
will be red.

Volume And More

The main volume of the Fury-800 can be controlled by the big
knob at the top left of the panel. Version 2.0 adds two more
controls: A +6dB and a BRIGHT switch. The first amplifies the
total output level by 6dB while the latter simulates the sound of
the Poly-800 by thinning it out a bit ("THIN” is a bad name for a
function - I'd better called it "BRIGHT").

The Play Modes

The Fury-800 has three play modes: POLY, CHORD, and SEQUENCER. To select POLY
or CHORD mode you have to press the respective button. To enter SEQUENCER mode
(and therefore to start the sequencer), press the START/STOP button. The HOLD
button does the obvious thing and played makes notes sound indefinitely.
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Selecting a Program

The Fury-800 has 64 programs numbered in a weird fashion from 1-1 to 8-8. The first
digit is called the bank; there are 8 banks (1 to 8) having 8 programs (1 to 8). To
select a program from the Fury-800 front plate you have to be in POLY or CHORD
mode (the LED display of the Fury-800 will show P or L at PARAMETER NO.).

PROGRAM MO PARAMETER NO.

Now you can dial in a new program number using the number pad. When you have
pressed the first button (the bank number) the display will show something like 4- at
PROGRAM NO. with a dash indicating that you have to press another number button
for the program. Using the BANK HOLD function you can “fix” the bank: Pressing a
number button will then immediately select the respective program of that bank. Note
that in BANK HOLD mode the dot at PROGRAM NO. will be lit, for example like 4.3
instead of 43.

You can also change the program by using the DOWN and UP buttons. The Fury-800
will then step downwards or upwards through the programs.

Editing Parameters

Clicking the PROG/PARAM button switches into PARAMETER mode where you can edit
the individual parameters of a program. Each parameter has a number similar to the
program numbers which can be determined by looking at the lower part of the front
plate (for example VCF Cutoff Resonance has the number 42 ). The display will show
the number at PARAM NO. and its value at VALUE.

PROGRAM NO PARAMETER NO.

To change the value of a parameter you have to use the DOWN and UP buttons. If the
value of the parameter has changed, the display will show a dot at VALUE. Note that
this only applies as long as you do not select a different parameter or program (this is
a funny feature of the original Poly-800 transported into the 21 century).

This is a rather tedious procedure when creating new sounds (note
that the Apollo astronauts used a similar procedure to program
their computer for landing on the moon!). Now, with the Fury-800
you can directly select and edit a parameter by clicking into the
parameter list at the front plate. This will show up a value slider
that can be moved up and down using the mouse. There is also an
option to show and edit the value sliders for all parameters at once
(see section Fehler: Verweis nicht gefunden).
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Memorizing and Playing Chords

Enter POLY mode, press the HOLD button, play some notes and press CHORD. Now
the display shows L at PARAMETER NO. and you can play the memorized chord over
the keyboard. Of course the number of notes of the chord is limited by the current
number of voices available (4 in DOUBLE mode, 8 in WHOLE mode, 64 in tweaked
polyphony mode). Note that if you memorize only one note, the CHORD mode turns
the Fury-800 into a monophonic instrument.

MIDI Learn And The Config File “fury800.ini”

Every parameter of the Fury-800 can be controlled by one MIDI controller. If you want
to change the assignment of MIDI controller (CC; MIDI Control Change) to Fury-800
parameter the MIDI Learn function comes in quite handy: Just click the MIDI Learn
button on the Sound Manager panel (caption turns red) and wiggle both the MIDI
controller and the parameter you want to assign (you can abort MIDI Learn by clicking
the button again). If you want to unlearn the assignment, right-click the MIDI Learn
button (the label now reads "UNLEARN") and activate it. Now wiggle the MIDI
controller or the parameter that you want to unlearn. To save the controller
assignments use “Save Configuration” in the Options Menu (see below); they are
stored in the fury800.ini configuration file. The exact location of this file depends on
your operating system and will be displayed when you click on “"Reload” or “Save
Configuration”.

Importing SysEx And Tape Data

You can import a Poly-800/EX-800/Poly-800 Mark II tape dump (WAV) or MIDI
System Exclusive (SYX) data file by clicking “Load SysEx/Tape...” in the Options Menu
(see below; be aware that the orginal Poly-800 Mark I does not feature MIDI System
Exclusive data export). You have following options:

Load SysEx Bank Data
Imports the whole bank of 64 programs from a SYX file. The programs will
automatically be set to Poly-800 MODE.

Load SysEx Sequence
Import the sequence contained in the SYX file into the current program. Sound
data is not affected.

Load Tape Bank Data
Imports the whole bank of 64 programs from a WAV file. The programs will
automatically be set to Poly-800 MODE.

Load Tape Sequence
Imports the sequence contained in the WAV file into the current program.
Sound data is not affected.

The imported programs will automatically be set to Poly-800 MODE. Note that if you
chose a Poly-800 Mark II SysEx of tape dump file, the Mark II specific settings for
delay and equalizer will be ignored.

Warning: There is no guarantee that the tape dump import will be successful as it
heavily depends on the quality of the recorded audio stream!
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Exporting SysEx Data

You can export a EX-800/Poly-800-MDK/Poly-800 Mark II MIDI System Exclusive
(SYX) data file by clicking “Save SysEx...” in the Options Menu. You have following
options:

Save SysEx Data (EX-800)
Exports the whole bank of 64 programs plus the sequence data of the current
program to a EX-800 SYX file.

Save SysEx Data (MIDI Dump Kit)

Exports the whole bank of 64 programs plus the sequence data of the current
program to a Poly-800 MIDI Dump Kit SYX file. MIDI Dump Kit (MDK) is a
hardware extension for the original Poly-800 Mark I.

Save SysEx Data (Poly-800 II)

Exports the whole bank of 64 programs plus the sequence data of the current
program to a Poly-800 Mark II SYX file. Specific settings for delay and equalizer
will not be set.

Note that sequence data may eventually be cut off due to the limited number of
sequence steps.
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Options Menu
When clicking on the MENU button, a context menu opens with the following options:

Copy Program

Copy current program to internal clipboard

Paste Program...

Paste internal clipboard to current program (either the full
program, only the sound, or only the sequencer data)

Init Program

Initialize the current program

Load Program...

Load a program file containing a patch to the Fury-800's current
program: Either the full program, only the sound, or only the
sequencer data.

Save Program

Save the Fury-800's current program to a program file

Load Bank... Load a bank containing 64 patches into the Fury-800: Either
from a FXB file, the original Poly-800 factory sounds, or the
Fury-800 version 1.0 factory patches.

Save Bank Save the Fury-800's 64 patches to a bank file

Load SysEx/Tape...

Load a bank or a sequence from a MIDI System Exclusive (SYX)
or a tape data (WAV) file (see Importing SysEx And Tape Data)

Save SysEX...

Save a bank plus the sequence data of the current program to a
MIDI System Exclusive (SYX) file (see Exporting SysEx Data)

Select Startup Bank

Select the bank file that should always be loaded when the
Fury-800 is started

Load Startup Bank

Load the Startup bank file; can also be used to check what the
current Startup bank is

Unselect Startup Bank

Unselect the current Startup bank

Default Path for
Program Files

Sets the default path for program and bank files

MIDI Thru

Set globally if MIDI data sent to Fury-800 should be sent
through to its MIDI output (stored in configuration file)

Ignore Program
Change

Set globally if MIDI Program Change data sent to the Fury-800
should be ignored (stored in configuration file)

Reload Configuration

Reload the Fury-800's configuration file

Save Configuration

Save the Fury-800's configuration file

Show All Parameters

Show or hide all parameter sliders of the Fury-800

Window Size...

Change the window size of the Fury-800

Save Window Size

Stores the current window size to the configuration file so that it
will be restored on the next loading of Fury-800

Check Online for
Update

When connected to the Internet, this function will check if a
newer version of the Fury-800 is available at fullbucket.de

Visit fullbucket.de

Open fullbucket.de in your standard browser
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Sequencer

The Poly-800 had a polyphonic step sequencer which was a very impressive feature by
that time, especially considering the price tag of this machine. However, one could
store only one sequence at a time. In contrast, each program of the Fury-800 has its
own sequence.

Recording a Sequence

The sequencer of the Fury-800 allows to record 1000 steps - in step mode only, there
is no real-time recording option. In the sequencer section, click on the RECORD light
to activate recording (the original Poly-800 used a switch at the back of the casing
instead). Press START/STOP to start recording (this will erase any existing sequence
of the current program!). The display will display the program number followed by an

“S” and the number of the current step (001) i.e. SOBI.

PROGRAM MO. PARAMETER NO. VALUE

Now press one ore more keys — once you release the last key, the respective note(s)
will be recorded for the current step, and the display shows the incremented step
number (8882 and so forth). Here are some more commands:

To enter a rest for the current step press the STEP button.

To tie the notes of the current step to the next step, do not release the pressed
keys but press the STEP button instead.

To delete the last step press START/STOP.
To finish recording click on the RECORD light again.

After you have recorded the 1000™ step, recording will stop automatically.

Playing a Sequence

Given that a sequence was recorded for the current program, pressing the
START/STOP button will start the sequencer (or stop it if it is already playing) - the
SPEED slider controls the speed. Parameters BE to BB offer the following options:

Synchronizing start/stop and speed with the host DAW
Start/stop on pressing a key
Transposing the sequence with respect to the currently played note

Note that the latter two features were not available with the Poly-800.
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Sound Creation
DCOs (Digital Controlled Oscillators)

The Fury-800 has two DCOs per voice, and each DCO offers two wave forms,
Sawtooth and Square. Furthermore, in addition to the Octave switch, there are four
more parameters called Harmonics (16, 8, 4, and 2’) that control the wave shape. In
fact, a DCO produces four square wave signals at 16’, 8, 4’ and 2'. These can mixed
by activating the Harmonic switches (sliders in case of the Fury-800).

The Wave parameter determines the weighting of the respective harmonics in the mix
- this way it is possible to create a staircase-shaped “Sawtooth” wave. Below are
some examples of possible wave forms.

This kind of additive synthesis is known from the KORG Delta (and my Nabla
simulation) and gave the Poly-800 its “rough” sound character (at least that’s what
folks say). Note again that the Harmonics and the Wave parameters of the Fury-800
are continuous and can have any value between 0 and 1.
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DOUBLE Mode

In WHOLE mode, the Poly-800 was 8-voice polyphonic and DCO2 was deactivated.
Switching to DOUBLE mode activated DCO2, but reduced polyphony to 4 voices.
However, this allows for much richer and more interesting sounds, last not least
because DCO2 features two additional parameters, namely Interval (0 to 12 notes)
and Detune.

If DOUBLE mode is set for the current program, the display will show a dot at
PARAMETER NO.

DEG (Digital Envelope Generator)

A very cool feature is that each DCO has its own envelope generator (DEG). Even
more, these DEGs are of an advanced ADSR type with two extra parameters called
Break Point and Slope.

V@i @ e @ k---® -
o : : ‘ :
£ ; i q \ '
=2 ' ' . :
L . ;] o ;
1 - : Sustain : :
! ¥ : ' level :
| Break .@ " i :
! point 1 ® ! :
1 level | : : i
(] * I 1 '

Attack | Decay | Slope Release

time time time time
TRIG —
OoN While keys are pressed OFF Time

ADBSSR envelope - the diagram right is ripped from the original Poly-800 Owner’s Manual.

Break Point is the level to which the envelope output will drop in Decay time after the
Attack phase has completed. Slope is the time until the envelope rises or falls from
Break Point to Sustain level.

VCF (Voltage Controlled Filter)

As stated earlier, the Poly-800 had only one filter, a
24 dB lowpass VCEF, for all voices. Technically this
means that the Poly-800 is a paraphonic
instrument with respect to the filter (the Fury-800
can be set into God Mode to make it a “true”
polyphonic machine).

The VCF has its own DEG and offers positive or
negative envelope modulation. Triggering modes of
the envelope are SINGLE (the DEG is only triggered if a key is pressed and no other
key was pressed) or MULTI (the envelope is triggered for each key pressed). Note that
in God Mode this setting has no effect. Also note that the filter will not self-oscillate
even if resonance is set to maximum.
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Noise

The white noise generator is controlled by its own LEVEL parameter and the VCF
envelope. No surprises here.

MG (Modulation Generator)

Traditionally, the LFOs of KORG instruments were called *Modulation Generators”, and
there is one in the Poly/Fury-800. It creates a sine wave, can be delayed and has
parameters for DCO and VCF modulation intensity.

Chorus

Although claimed to be stereo, the chorus was a mono effect where the inverted effect
signal has been mixed with the right output of the synthesizer. Besides a somehow
uncomfortable listening experience (especially under headphones) this becomes
audible when the left and right output are mixed to a mono sum - then the chorus
signal will be canceled out completely. Thus, the Fury-800 features an additional
switch to (de)activate this “stereo” option.

Note that the speed of the chorus effect was fixed on the Poly-800. The Fury-800 adds
a hidden parameter (#61) to change the speed.

Modulation Wheel

For real-time modulation purposes, the Poly-800 like many of its relatives featured the
cool KORG joystick. As with all my other KORG simulations I added some controls that
“emulate” the joystick using the ubiquitous modulation wheel. Therefore the Fury-800
has sliders for controlling each the MG-to-DCO and MG-to-VCF intensities controlled
by the modulation wheel.

Velocity

The Poly-800 did not react to velocity information but the Fury-800 does. The
intensity can be controlled by the VELOCITY slider.
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Parameters

DCO1
parameter ID | number |description
OCTAVE 5 H Octave
WAVE 6 12 Wave form (Sawtooth or Square)
16’ 7 13 16" harmonic level
8’ 8 Y 8’ harmonic level
4’ 9 1S 4’ harmonic level
2’ 10 1= 2’ harmonic level
LEVEL 11 1 Total level

DCO Mode
parameter ID | number |description
MODE 12 '8 DCO mode (WHOLE or DOUBLE)

DCO2
parameter ID number description
OCTAVE 13 2 Octave
WAVE 14 cc Wave form (Sawtooth or Square)
16’ 15 c3 16" harmonic level
8’ 16 2y 8’ harmonic level
4’ 17 2s 4’ harmonic level
2’ 18 2b 2’ harmonic level
LEVEL 19 e Total level
INTERVAL 20 3} Interval in notes
DETUNE 21 Jje Detuning

Noise
parameter ID number description
LEVEL 22 33 Noise level

VCF
parameter ID number description
CUTOFF 23 i Cutoff frequency
RESONANCE 24 ye Resonance
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parameter ID number description
KBD TRACK 25 Y3 Keyboard tracking
POLARITY 26 Yy Polarity of DEG modulation
EG INTENSITY 27 yg Intensity of DEG modulation
TRIGGER 28 Yye Trigger mode (SINGLE or MULTI)
Chorus
parameter ID number description
CHORUS 29 yg Chorus on or off
DEG1 (for DCO1)
parameter ID number description
ATTACK 30 Gl Attack time
DECAY 31 G¢e Decay time
BREAK POINT 32 G3 Break Point level
SLOPE 33 gy Slope time
SUSTAIN 34 gS Sustain level
RELEASE 35 =1 Release time
DEG2 (for DCO2)
parameter ID number description
ATTACK 36 B! Attack time
DECAY 37 Be Decay time
BREAK POINT 38 B3 Break Point level
SLOPE 39 BY Slope time
SUSTAIN 40 BS Sustain level
RELEASE 41 B6 Release time

DEG3 (for VCF and Noise)

parameter ID number description
ATTACK 42 il Attack time
DECAY 43 12 Decay time
BREAK POINT 44 13 Break Point level
SLOPE 45 Y Slope time
SUSTAIN 46 1S Sustain level
RELEASE 47 16 Release time
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MG

parameter ID number description

FREQUENCY 48 8! MG speed

DELAY 49 B2 Delay time

DCO 50 83 DCO modulation level

VCF 51 BY VCF modulation level
Sequencer

parameter ID number description

SEQ. CLOCK 52 BE Sync to host DAW

PLAY ON NOTE 53 B1 Start/Stop on key pressed

TRANSPOSE 54 B8 Transpose sequence on played note
Other Parameters

parameter ID description

VOLUME 0 |Total volume

TUNE 1 Master tune

BEND 2 |Amount of pitch bending

SEQ. SPEED 3 Sequencer speed

KEY ASSIGN 4 Keyboard mode (POLY or CHORD)

VOICES 55 |Number of voices (8/4 or 64)

GOD MODE 56 |God Mode on or off

"STEREO” CHORUS 57 |“Stereo” chorus effect on or off

WHEEL TO DCO 58 |Intensity of Mod Wheel to DCO modulation

WHEEL TO VCF 59 |Intensity of Mod Wheel to VCF modulation

VELOCITY 60 |Intensity of velocity

CHORUS RATE 61 |Chorus speed (hidden parameter)

MODE OF OPERATION 62 |POLY-800 MODE or BUCKET MODE

+6dB 63 | +6dB gain boost off or on

BRIGHT 64 | Bright function off or on
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Frequently Asked Questions

How do I install the Fury-800 (Windows VST2 32 bit version)?

Just copy the files fury800.d11 from the ZIP archive you have downloaded to your
system's or favorite DAW's VST2 plug-in folder. Your DAW should automatically
register the Fury-800 VST2 plug-in the next time you start it.

How do I install the Fury-800 (Windows VST2 64 bit version)?

Just copy the file fury80064.d11 from the ZIP archive you have downloaded to your
system's or favorite DAW's VST2 plug-in folder. Your DAW should automatically
register the Fury-800 VST2 plug-in the next time you start it.

Note: You may have to remove any existing (32 bit) fury800.d11 from your VST2
plug-in folder or else your DAW may screw the versions up...

How do I install the Fury-800 (Windows VST3 64 bit version)?

Just copy the files fury800.vst3 from the ZIP archive you have downloaded to your
system's or favorite DAW's VST3 plug-in folder. Your DAW should automatically
register the Fury-800 VST3 plug-in the next time you start it.

How do I install the Fury-800 (Mac VST2/VST3/AU 64 bit)?

Locate the downloaded PKG package file fury800 2 4 0 mac.pkg in Finder (!) and do
a right- or control-click on it. In the context menu, click on “"Open”. You will be asked
if you really want to install the package because it comes from an “unidentified
developer” (me ©). Click “OK” and follow the installation instructions.

What is the "N” version of the Fury-800?

The “N” version is the non-resizable version of the Fury-800 that should run on almost
any older Windows or Mac machine. So if you have problems with the standard Fury-
800 version, this is the one to go for.

What is the plug-in ID of the Fury-800?
TheIDis£800.

Why is there a BUCKET MODE and Poly-800 MODE?

This was the best way to remain backwards compatible to the Fury-800 version 1.0
(see sections Two Modes, Two Worlds and POLY-800 MODE vs. BUCKET MODE).

How do I know if a new version of the Fury-800 is available?

When connected to the Internet, open the File menu (see section Options Menu) by
clicking the disk icon and select the entry "Check Online for Updates”. If a new version
of the Fury-800 is available on fullbucket.de the respective information will be shown
in @ message box.

How do I resize the Fury-800 window?

Just grab the yellow triangle at the bottom right of the Fury-800 window and drag it.
You can save the current window size using the menu entry “Save Window Size” in
the Options Menu.
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Can I load/paste only the sound or sequencer data of a program?

Yes you can! Please see section Options Menu.
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